Welcome to training on the use of the Quest electronic form submission system presented by the Indiana Department of Child Services.

Audio Script:
Welcome to training on the use of the Quest electronic form submission system presented by the Indiana Department of Child Services.
Slide 2 - What is Quest?

What is Quest?

- Quest is a web-based system that allows DCS Employees to complete certain required forms electronically

- Forms available include:
  - Intake Officer’s Report of Preliminary Inquiry and Investigation (PI)
  - Program of Informal Adjustment (IA)
  - Predispositional Report (PDR)
  - Progress Report
  - Progress Report - Permanency
  - Modification Report

Audio Script:
Quest is a web based system that allows DCS Employees to complete certain required forms electronically.

Forms available include:
- Intake Officer's Report of Preliminary Inquiry and Investigation, also called a PI - The family case manager makes a preliminary inquiry, or assessment, into whether there is probable cause to believe the child is in need of services. If so, the PI is filed with a court if there is need for further action. It is filed together with a Child in Need of Services Petition, also called a CHINS petition, or an Informal Adjustment, also called an IA. If the child is removed, the PI also serves as the evidence of probable cause to report the removal (with court approval or without) and that reasonable efforts to avoid removal have been made.

(continued on next page)
• Program of Informal Adjustment, also called an IA - After the preliminary inquiry is completed, the family case manager may implement a program of informal adjustment if the FCM has probable cause to believe that the child needs some services, but that formal court oversight is not necessary. This type of referral indicates that less intervention of the court is anticipated than in a CHINS proceeding.

• Predispositional Report, also called a PDR - Upon finding that a child is a child in need of services, the FCM prepares the PDR to inform the court of programs, services, and the family’s financial information necessary and recommended to implement the DCS permanency plan for the child. In most instances, the plan will be reunification.

• Progress Report - The FCM will prepare this report after the dispositional decree is entered documenting the progress made in implementing the established provisions and conditions of the decree. The filing of this report may coincide with a hearing on the CHINS proceeding and may happen as frequently as every three months.

• Progress Report-Permanency - This report is similar to the Progress Report in format, but adds additional information required when the child has been removed for more than twelve months, as soon as six months in some situations, or within 30 days of a no reasonable efforts finding. The Court is required to hold a hearing if the child remains in the home for 12 months after the dispositional decree and the case is still open. The report may also be prepared at such times as the Court may require. In this report, the FCM will address issues leading to a permanency plan for the child.

• Modification Report - A modification report is prepared by the FCM if DCS is requesting a modification of the dispositional decree. The format is similar to the PDR. Notices of a modification hearing are the same as the required Notices for dispositional hearings.

• Please remember that no Social Security Numbers should be included in any of these reports. Even if there is an opportunity on a screen to add this information, the FCM should leave this field blank.
Slide 3 - If you are a Quest County...

If you are a Quest County...

- Quest county FCMs should contact the Quest Administrator for their specific county to receive a login and password
- The login screen will look exactly like the one shown in this training, but will be county-specific
- After logging in, click on the Main Menu, select 'Miscellaneous', then select 'Document Options', and finally select the 'Go to Document/docket entries' option which will take you to the name search screen
- After arriving at the name search screen, you may search for the name (or Quest number if you have it), and at that point you will reach the Add a document screen.
- All other processes are identical to those presented in this training

Audio Script:
For Quest county FCMs, please contact the Quest administrator for your county to receive a login and password to your county’s Quest system. Your login screen will look exactly like the one shown in this training, but will be county-specific. After signing in and arriving at the Main Menu, the process to arrive at adding a new document will be slightly different than the one shown in this training. Click on the Main Menu, select Miscellaneous, then select Document options from the submenu, and then select the option Go to Document/docket entries which will take you to the name search screen. From the name search screen, enter the name or Quest number if you have it, and it will take you to the add a document screen where you may begin the process of adding a new document. All other processes are identical to those presented in this training.
Slide 4 - How to Access Quest in Non-Quest Counties

How to Access Quest in Non-Quest Counties

- For Non-Quest counties, access to Quest is available at:
  

Audio Script:

If you are in a non-Quest county, Quest can be accessed by visiting the web address displayed on your screen in a web browser. When you are finished viewing this slide, click Continue.
The following simulations will illustrate the process of completing an electronic form using the Quest system.

Follow the on-screen and audio prompts to complete a DCS Report of Preliminary Inquiry (PI) and then a Predisposition Report (PDR).

These steps can be used to complete any of the forms available with this process.

Audio Script:
The following simulations will illustrate the process of completing an electronic form using the Quest system.
Follow the on-screen and audio prompts to complete a DCS Report of Preliminary Inquiry, and then a Predisposition Report. These are the only two forms that will be demonstrated in this training.
These steps can be used to complete any of the forms available with this process.
Audio Script:
From the Gottlieb and Wertz website, click on the Log on to Quest link near the top of the page.
Slide 7 - Quest Preliminary Inquiry (PI) Simulation 1

Audio Script:
On the Quest Sign on page, in the Jurisdiction box, enter DCS in all lower case. In the User ID field, enter your ICWIS ID in lower case, and in the password box, enter your ICWIS ID in lower case. In this example, the sign on information has already been entered for you. Click the Submit button to sign in.
Audio Script:

Click the Menu button in the left column.
Audio Script:
Select Miscellaneous from the main menu.
Audio Script:
Select Local Options from the submenu.
Audio Script:

Click the ICWIS Interface Link on the Local Options page.
Slide 12 - Quest Preliminary Inquiry (PI) Simulation 6

Audio Script:

On the ICWIS interface page, enter the ICWIS number in the Case Number text box. In this example, a case number has been entered for you. Click the Submit button to continue.
Audio Script:
The information from ICWIS has now been imported and displays on the page. Now, click the Update Button at the bottom of the screen.
Audio Script:
Click the Add a new document link.
Audio Script:
Enter DCS in the List templates containing box. In this example it has been entered for you. You will be given options of the six forms available for you to complete. Click DCS Preliminary Inquiry from the drop down list of options in this simulation.
Click the Update button.
Audio Script:

Select the child or children for whom this report is being created. If there is only one child involved with this report, select that child’s name, and then click the Update button to proceed. If there is more than one child, for example, brothers and sisters, and this PI will apply to all of those children, you must add the additional childrens’ names to this screen in order to select them for this report. To do that, click the Get Name button to add their names to this PI. In this example, the selection has been made for you. Click the Update Button to proceed.
Select the child’s parent or guardian from the list. If the name or names are there, select them and then click the Update button. If the name does not appear, you must add this information. In this example, the child's mother is not listed. Please click the New Relative link to add information for a new relative.
Audio Script:
On the Relative Detail screen, click the Get Relative Name button.
The Name Search screen will appear. This allows you to search the system for a relative who has already been entered. The best way to conduct a name search is to enter the person’s last name in the text box labeled “Last”, and first name in the text box labeled “First”. If there are no responses, you can select the sound alike checkbox which will search for names that sound similar to what you typed. If there are still no responses, you can type the first few letters of the person’s last name followed by the percent sign. This will provide you with the broadest search terms possible. If this search yields too many results, you can further refine it to decrease the number of results. Enter other information known such as date of birth or social security number using the advanced search option. It is best practice to first search the name you have been told is the parent or guardian, and if that fails search with the broadest terms possible. In this example, we are searching for the first few letters of the mother’s last name and the first letter of her first name. Click the Submit button to proceed.
If your search yields results, they will display under the Submit button. If your search does not yield any results, like in this example, you will see a message near the top of the screen that says No Matches Found. If this is the case, you may try to refine your search terms to make them broader, or choose to Add a new name. In this example, we will add a new name. Click the Add a new name link to proceed.
Slide 22 – Quest Add Relative 4

Audio Script:
The Person Detail screen will allow you to enter the name, and other identifying information about the person you are adding. Enter all currently available information such as first and last name, date of birth, social security number, race, age, and all fields listed on the screen. In this example, information about the child’s mother has been added for you. Click the Update button to proceed.
Once you have added the new relative's name and basic identifying information, you may add additional information about that person such as addresses, contact telephone numbers, emergency contact information, etc., by clicking the links near the top of the page. Click the Update Button to proceed.
Audio Script:

In this case, mother’s name, Martha Smith, now appears as the Relative. At this time, you would complete the rest of the information requested on the screen. In this example, it has already been completed for you. Click the Update button to proceed.
Audio Script:
The mother now appears in the list, and can be selected as the child’s parent, guardian or custodian. In this example, the child’s parents have already been selected for you. Click the Update button to proceed.
Slide 26 - Quest Preliminary Inquiry (PI) Simulation 13

**Audio Script:**

On this screen you will enter each child’s name and the placement location where the child is living. For instance, enter the child’s name and then state whether the child is with the parent by name, in a foster home, group home, residential or other location. Click the Update button to proceed.
Audio Script:
Enter the date of the next hearing. This will usually be either the same date the document is prepared or in the next few days. In this example, the date of the next hearing has been entered for you. Click the Update button to proceed.
Slide 28 - Quest Preliminary Inquiry (PI) Simulation 15

Audio Script:
Select yes or no to indicate whether the child or children were removed from the home. In this example, yes has already been selected for you. Click the Update button to proceed.
Audio Script:

Enter the date and time the children were removed from their parent or residence and taken into care by DCS. In this example, the date and time of the removal have been entered for you. Click the Update button to proceed.
Audio Script:

Select with whom the children lived prior to removal. If children resided with someone other than a parent or guardian listed, you will need to add this information by selecting the Update Information of either Person detail or New Relative and completing the appropriate information. In this example, Martha Smith, the child’s mother, has been selected for you. Click the Update button to proceed.
Audio Script:
Select whether the children were taken into custody with a court order or without a court order. In this example, without, has already been selected for you. Click the Update button to proceed.
Audio Script:

Enter the date and time that the DCS assessment began, that is, when the FCM arrived at the home, school, or other location to gather information. In this example, the date and time of the event has already been entered for you. Click the Update button to proceed.
Audio Script:
On this screen, you will enter the location where the FCM assessment began. Click the Update button to proceed.
Audio Script:

This screen prompts you to describe the nature of the report. Descriptions could include Abuse and/or neglect, Abandonment, Child molestation, or other conditions indicated by the report source. In other words, describe the allegations originally reported, such as child has been left alone, child has been beaten, home conditions are unhealthy, etc. Click the Update button to proceed.
Audio Script:

This screen allows you to enter any pertinent facts or evidence of probable cause that have been gathered through the assessment. Include all visual and oral information necessary to justify the actions taken by the FCM. Click the Update button to proceed.
Audio Script:
This screen prompts you to enter a description of the parent, guardian or custodians response to the facts and evidence of probable cause. In other words, if the parent, guardian or custodian has been interviewed, what was their response or reaction to the description of the home, the allegations of hitting or beating of the child, why the child was wandering unsupervised in the neighborhood, etc. Another example might be: does the parent believe the allegations. Click the Update button to proceed.
Audio Script:

On this screen, you will enter the child or children’s statement related to the interview and assessment. This can include any information gathered from the child during the assessment either from law enforcement, DCS staff or others. Click the Update button to proceed.
Provide any other pertinent information regarding the facts and information gathered. If law enforcement is involved, please identify each officer by name, and list which law enforcement agency they are affiliated with.

Audio Script:
Provide any other pertinent information regarding the facts and information gathered. If law enforcement is involved, please identify each officer by name, and list which law enforcement agency they are affiliated with. Click the Update button to proceed.
Audio Script:

Select all of the reasons why the child or children are in need of services from the list provided. The first option is most often selected as it refers to the inability, refusal or neglect to provide for the child’s safety or well-being. The others may also be selected depending upon the specific allegations and circumstances. In this example, the reasons have been selected for you. Click the Update button to proceed.
Audio Script:
Select every parent, guardian or custodian who will be a party to this action, in order to list additional information in the PI. In this example, we will only enter information on the mother. Mother has been selected from the list. Click the Update button to proceed.
Audio Script:
Select the mother from the list of family members. In this example the mother, Martha Smith, has been selected for you. Click the Update button to proceed.
Audio Script:

Enter mother’s maiden name if known and any other names that mother has used such as married names, or aliases for any other reason. Click the Update button to proceed.
Audio Script:
This screen prompts you to enter employment information for the mother, if known. Click the Update button to proceed.
Audio Script:

You are now asked to select the mother’s marital status from the list provided, if known. In this example, the mother’s marital status has been selected for you. Click the Update button to proceed.
Audio Script:
Select yes or no to indicate if the mother’s current location is known. In this example, no has been chosen for you. Click the Update button to proceed.
Audio Script:
This screen prompts you to specify any known CPS history for the mother. Click the Update button to proceed.
Audio Script:
Select the child or children for whom the PI is being prepared. You may select more than one child. The information on each child will be asked after completion of the information of the previous child. In this example, only one child has been selected. Click the Update button to proceed.
Audio Script:
This screen simply informs you that the following set of questions refer to child 1. If you select more than 1 child on the previous screen, you will see a similar information page prior to answering questions for each child. Click the Update button to proceed.
Audio Script:
In this example, there is only one child. Select that child’s name from the list provided. If there were more than one child, you would still only select one child at this time. In this example, the child has already been selected for you. Click the Update button to proceed.
Audio Script:
Select who has legal custody of the child. The screen should list known parents of the child. If both parents have custody, both parents should be selected. In this example, the father’s name has been selected for you. Click the Update button to proceed.
You are now prompted to enter what legal custody of the child is pursuant to. For instance, if the child’s parents are married, they both have custody. If there is a divorce or paternity decree, the decree will outline the custody arrangement. If there is no decree, mother is the presumed custodial parent. If custody arrangements are unknown, simply state that custodial arrangements are not known at this time. Click the Update button to proceed.
Audio Script:

On this screen, you are asked to select the individual with whom the child lived prior to removal. In this example, the mother, Martha Smith, has been selected for you. Click the Update button to proceed.
Audio Script:

You are now asked to select who else resides in the house with the child. If an individual residing in the house with the child does not appear on the list, click the Add a new relative link to add them. In this example, Kristine Johnson, the child’s half sister has been selected for you. Click the Update button to proceed.
Slide 54 - Quest Preliminary Inquiry (PI) Simulation 41

Audio Script:
Select all of the child’s siblings from the list. If a sibling does not appear on the list, click the Add a new relative link to add them. In this example, Kristine Johnson, the child’s half sister has been selected for you. Click the Update button to proceed.
Audio Script:
Select yes or no to indicate whether the child is currently placed in close proximity to the home and neighborhood, if they have been removed. In this example, no has been selected for you. Click the Update button to proceed.
Select yes or no to indicate whether the child is able to maintain essential connections, including sibling and parental contact. In this example, yes has been chosen for you. Click the Update button to proceed.
Audio Script:
Select yes, no or unknown to indicate whether the child has an Individualized Education Plan – IEP. An IEP is a plan through the child’s home school to assist the child with any educational difficulties the child may have as identified through a formal evaluation process. In this example, yes has been chosen for you. Click the Update button to proceed.
Audio Script:
Select yes or no, to indicate if there are special accommodations at the child’s school. This could include whether or not the child is handicapped, has visual challenges, has mentoring services etc. In this example, yes has been chosen for you. Click the Update button to proceed.
Audio Script:

On this screen, you are prompted to enter the name of the child's school, if child attends school. It is not necessary to include the school address. Click the Update button to proceed.
Audio Script:

Enter the grade number the child is currently attending in the text box provided. For instance, if the child is in first grade, type the number 1 followed by st (1st). If the child has not yet started school, type “not in school”. In this example, 10th, has already been entered for you. Click the Update button to proceed.
Audio Script:
You are now prompted to enter information regarding the child’s physical health, including any special needs, accommodations, and physical challenges that the child may have. If there are no special circumstances, indicate that the child appears healthy. Click the Update button to proceed.
Audio Script:

On this screen, you will enter information regarding the child’s mental health, including any known diagnosis, therapeutic interventions or prescribed medication. Click the Update button to proceed.
Audio Script:

You are now prompted to enter any prior DCS history for the child. If the child has previously been involved with an allegation of abuse and neglect that is contained in ICWIS, please enter the year, allegation (abuse, neglect, abandonment, etc.), and determination (substantiated, unsubstantiated or indicated). Click the Update button to proceed.
Audio Script:
This screen requires you to enter any prior court involvement for the child, including CHINS, Informal Adjustment, Juvenile Delinquency, or Juvenile status. Juvenile Delinquency includes arrests for things like shoplifting, theft, auto theft, battery, drugs, etc. Juvenile Status includes truancy, runaway, drinking under age, etc. Click the Update button to proceed.
Audio Script:

If you have selected more than one child, you will be asked to complete the same series of questions as they apply to each additional child. If not, this screen simply informs you that you are done with answering child specific information. Click the Update button to proceed.
Audio Script:
If removal has occurred, select yes or no, to indicate what steps were taken to avoid removal. If yes is selected, you will be prompted to explain the efforts made to avoid removal. If no is selected, then no services were offered to avoid removal because the safety of the child, and the emergency of the circumstances precluded any services. In this example, yes has been selected for you. Click the Update button to proceed.
Audio Script:
You are now asked to provide a description of the family services available prior to the removal of the child or children. This could include services such as counseling, Intensive Family Preservation Services, an Informal Adjustment, Community Partners services, family support services, drug/alcohol treatment, etc. Click the Update button to proceed.
Audio Script:
This screen prompts you to provide information if the child was removed as part of an emergency situation, where the child’s parent, guardian, or custodian was unwilling or unable to properly address the situation to protect the child. This may include things such as extreme physical or sexual abuse, uninhabitable living circumstances, or other circumstances indicating that the child’s safety was at immediate risk. Click the Update button to proceed.
Audio Script:

This screen requires you to explain why the efforts made were reasonably thought to be able to protect the safety of the child or children. For instance, if the child was removed, explain why leaving the child in the home would jeopardize the child’s safety and well-being. Things such as extreme physical or sexual abuse create a risk for the child to remain in that environment. However, if the child remains in the home, explain why the child is safe in that home, for instance. Intensive Family Preservation services provide sufficient safety and well-being for the child to remain there. Click the Update button to proceed.
Slide 70 - Quest Preliminary Inquiry (PI) Simulation 57

Audio Script:
Select yes or no to indicate whether the child should be removed. For instance, if the child has been removed and this is a CHINS proceeding, click Yes. If the child is currently in the home and should be removed, click Yes. However, if this is a PI for an IA, the child must be in the home and therefore, no should be clicked. In this example, yes has been selected for you. Click the Update button to proceed.
Audio Script:

Now you are required to explain why it is in the best interest of the child or children to be removed from the home environment, and why remaining in the home would be contrary to the health and welfare of the child or children. For instance, state and explain that the child’s physical or mental condition is seriously endangered or impaired and describe that danger; that may include extreme physical abuse, sexual abuse, uninhabitable home environment, etc. Click the Update button to proceed.
Audio Script:
Select your final recommendation from the list of options. In this example, Filing of Petition Alleging CHINS has been selected for you. Click the Update button to proceed.
Slide 73 - Quest Preliminary Inquiry (PI) Simulation 60

Audio Script:
This screen prompts you to enter the reasons for your recommendation. This includes: mother unable to provide for the safety of the child without DCS and Court involvement, mother unable to protect the child from abuse by her boyfriend, parent or parents drug involvement, parents are both incarcerated, etc. Click the Update button to proceed.
Audio Script:
Now you will select an FCM to assign to the case. Most often, this will be the person preparing the PI. If the FCM is not listed on this screen, click the new case assignment link to add them. In this example, the FCM has been selected for you. Click the Update button to proceed.
Audio Script:

You are now prompted to enter the name of the county where the PI is being filed. In this example, the county has already been entered for you. Click the Update button to proceed.
Audio Script:

Now you are asked to enter the name of the supervisor who will be approving this document. Type this name in the box provided. In this example, the supervisor’s name has been entered for you. Click the Update button to proceed.
Audio Script:

On this screen, enter the current date as a two digit month, two digit day, and four digit year. In this example, a date has been entered for you. Click the Update button to proceed.
Audio Script:

Now you are required to enter the ID, and agency of the supervisor who will be approving this document. If you are unsure of the supervisor's ID, click the lookup button, to complete a search. The Employer agency will always be DCS, Department of Child Services. In this example, these fields have been completed for you. Click the Update button to proceed.
Audio Script:
Describe any items that will be attached to this document. If the child was taken into custody without a verbal or written court order, check the appropriate box. Click the Update button to proceed.
Slide 80 - Quest Preliminary Inquiry (PI) Simulation 67

Audio Script:
This screen informs you that there are no more questions to process. Your report of Preliminary Inquiry is complete. If you want to return to the most recent question, click backwards. If you want to go back to the first question, click top. If you want to review the form in its entirety as it has been prepared, or if you would like to send a copy of the form to an attorney to review and make suggestions, click preview and then send an email to the attorney in your county. If you want to complete the form, click finish.
Audio Script:
You will now be taken through the process of completing a DCS Predisposition Report. To begin, click the Menu button in the left column.
Slide 82 - Quest Pre-Disposition Report (PDR) Simulation 2

Audio Script:
Select Miscellaneous from the main menu.
Audio Script:
Select Local Options from the Submenu.
Audio Script:
Click the ICWIS Interface Link on the Local Options page.
Slide 85 - Quest Pre-Disposition Report (PDR) Simulation 5

Audio Script:
On the ICWIS interface page, enter the ICWIS Case number. In this example, a case number has been entered for you. Click the Submit button to continue.
Audio Script:
The information from ICWIS has now been imported, and displays on the page. Now, click the Update button at the bottom of the screen.
Audio Script:

Click the Add a new document link.
Audio Script:

Enter DCS in the List templates containing box. In this example, it has been entered for you. Select DCS Pre-Disposition Report/Modification Report from the drop down list of options. You will later be able to select whether this is a Pre Disposition Report or a Modification Report.
Audio Script:
Click the Update button.
Audio Script:
Select the child or children for whom this report is being created. Once again, if you want to add a sibling so that this document includes multiple children, you will need to click on the Get Name button to locate the additional child or children. In this example, the selection has been made for you. Click the Update Button to proceed.
Audio Script:
Select the child’s parent, guardian or custodian from the list. If a name doesn't appear on the list, click the New Relative link to add it. In this example, the child’s parents have been selected for you. Click the Update button to proceed.
Audio Script:
On this screen you will enter each child’s name and the placement location where the child is living. For instance, enter the child’s name and then state whether the child is with the parent by name, in a foster home, group home, residential or other location. Click the Update button to proceed.
Audio Script:
Select the current permanency plan for the child. In this example, Reunification has been selected for you. Click the Update button to proceed.
Audio Script:

Select PDR or Modification to indicate what type of report this is. In this example, PDR has been selected for you. Click the Update button to proceed.
Slide 95 - Quest Pre-Disposition Report (PDR) Simulation 15

Audio Script:

Enter the date of the next hearing. This will be the date of the Dispositional Hearing set by the court. In this example, the date of the next hearing has been entered for you. Click the Update button to proceed.
Audio Script:

Enter the name of the DCS Attorney. In this example, the name of the attorney has been entered for you. Click the Update button to proceed.
Audio Script:

Enter the name of the DCS Family Case Manager. In this example, the FCM's name has been entered for you. Click the Update button to proceed.
Audio Script:
If the child has not been removed from the home state “child has remained in the home”. If the child has been removed, list the date of removal. If the child was returned home after removal, and has been removed again, list the first date of removal, date of return home, and date of any subsequent removals. Click the Update button to proceed.
Slide 99 - Quest Pre-Disposition Report (PDR) Simulation 19

Audio Script:

On this screen, since you are doing a predisposition, the allegations have been found true as to one, several, or all parties. List the name of the parent/guardian or custodian, whether there was a true or not true finding together with the date of that finding. Finally, state whether the true finding was by an agreed entry or through a fact finding hearing. Click the Update button to proceed.
Audio Script:

If you are using this template for a modification report, you will be asked at this time to list the date of the dispositional decree. Since this is a PDR, no date has been entered. Click the Update button to proceed.
Audio Script:

Enter a summary describing the facts and circumstances resulting in the agreed entry or the true finding through the fact finding hearing. You may be able to copy and paste this from the PI. However, often the facts stated in the PI are different from those agreed to or presented at the fact finding hearing. This should be a narrative summary, and not be detailed. Generally, this should be no longer than half of a page because it is to inform the parties of the underlying issues presented in this case. Click the Update button to proceed.
Audio Script:
This screen requires you to enter any prior court involvement for the child, including CHINS, Informal Adjustment, Juvenile Delinquency, or Juvenile status. Juvenile Delinquency includes arrests for things like shoplifting, theft, auto theft, battery, drugs, etc. Juvenile Status includes truancy, runaway, drinking under age, etc. Click the Update button to proceed.
Audio Script:
You will now be asked to answer a series of questions about each parent, guardian, or custodian. The questions for each will be the same; however, you may not have all of the necessary information for each party. You should fill in all of the information for each party available at the time that this document is prepared. At this stage, you will be selecting Mother and completing all known information about her. For demonstration purposes, Mother has already been selected for you. Click the Update button to proceed.
Audio Script:
Enter mother’s maiden name if known and any other names that mother has used such as married names, or aliases for any other reason. Click the Update button to proceed.
Specify the mother's known marriages. If Mother has never been married, indicate that. If Mother has been married, enter information, if known, about the date of marriage, the individual she was married to and whether the marriage was dissolved or not.

Audio Script:
Specify the mother’s known marriages. If Mother has never been married, indicate that. If Mother has been married, enter information, if known, about the date of marriage, the individual she was married to and whether the marriage was dissolved or not. Click the Update button to proceed.
Specify the names and dates of birth for all of the mother’s children, whether they are named in this case or not. This may include older siblings who are now adults.

Audio Script:
Specify the names and dates of birth for all of the mother’s children, whether they are named in this case or not. This may include older siblings who are now adults. Click the Update button to proceed.
Audio Script:
Check yes or no to indicate whether or not the mother has been ordered to pay support through a divorce, paternity, or other legal proceeding. In this example, yes has been selected for you. Click the Update button to proceed.
Audio Script:

Enter the amount of support the mother is ordered to pay, if any. In this example, the amount has been entered for you. Click the Update button to proceed.
Audio Script:

Fill in the blank to indicate how often the mother pays support. For example, the mother pays $25 per week. In this example, the amount has been entered for you. Click the Update button to proceed.
Audio Script:
On this screen, you must list the names of the children for whom the mother pays support. Click the Update button to proceed.
Audio Script:

If mother pays support, enter the Court and Cause Number related to each of mother’s child support orders, if known. Click the Update button to proceed.
Audio Script:

Check yes or no to indicate whether or not the mother currently receives support based on a divorce, paternity, or other court order. In this example, yes has been selected for you. Click the Update button to proceed.
Slide 113 - Quest Pre-Disposition Report (PDR) Simulation 33

Audio Script:

State how much money Mother is ordered to receive each time a payment is received pursuant to the court order. In this example, the total amount has been entered for you. Click the Update button to proceed.
Audio Script:

Indicate how often the mother receives support, for example weekly, bi-weekly, monthly. In this example, the time period has been entered for you. Click the Update button to proceed.
Select the child for whom the mother receives support from the list of names. In this example, the child has been selected for you. Click the Update button to proceed.
Audio Script:

Now you are asked to describe the mother's educational background. In other words, what was the last grade completed or degree received. For instance, GED, high school diploma, community college or last grade attended, etc. Click the Update button to proceed.
Audio Script:

Next, you are asked to generally describe the mother’s occupation. For example, hair dresser, store clerk, nurse, teacher, postal worker, etc. Click the Update button to proceed.
Enter information about the mother’s employer. List the name and address of employer.

Audio Script:
This screen allows you to enter information about the mother’s employer. List the name and address of employer. Click the Update button to proceed.
Audio Script:

Now you are asked to enter the mother’s work telephone number. Click the Update button to proceed.
Select yes or no to indicate whether or not the mother is of Native American heritage. This does not mean whether or not Mother claims membership of a registered Native American tribe. Only whether or not Mother states she has Native American heritage, to whatever degree. In this example, no has been selected for you. Click the Update button to proceed.
Audio Script:
This screen prompts you to enter the source of the information about the mother. This includes from mother directly, father, relatives, friends, technology such as ICWIS or ISETS or ICES, police reports, court information, etc. Click the Update button to proceed.
Audio Script:

Select the father from the list of relatives. In this example, the father has already been selected for you. Click the Update button to proceed.
Audio Script:
Enter any other names that father has used, including aliases or nicknames. Click the Update button to proceed.
Audio Script:
Specify the father’s known marriages. If father has never been married, indicate that. If father has been married, enter information, if known, about the date of marriage, the individual he was married to and whether the marriage was dissolved or not. Click the Update button to proceed.
Specify the names and dates of birth for all of the father’s children. Click the Update button to proceed.
Audio Script:

Select all of the ways that paternity has been established for the father’s children. For instance, if paternity has not been established for a child, select that option; if paternity has been established by affidavit, for one or more children, select that option; if paternity was established because the father was married at the birth of the child, and if paternity was established by a court order under a paternity case, select both options. In other words, you may end up clicking one or more of these categories. In this example, “Paternity established by Paternity Affidavit for one or more” has already been selected for you. Click the Update button to proceed.
Audio Script:
List the names of any or all of the children for whom paternity was established by Paternity Affidavit. Click the Update button to proceed.
Audio Script:
Select yes or no to indicate whether the father has been ordered to pay support under divorce, paternity or other court order. In this example, yes has already been selected for you. Click the Update button to proceed.
Audio Script:

Enter the amount of support the father is ordered to pay in the text box provided. In this example, the amount has already been entered for you. Click the Update button to proceed.
Audio Script:

Indicate how often the father pays support, for example weekly, bi-weekly, monthly. In this example, the time period has been entered for you. Click the Update button to proceed.
Audio Script:

Next, you are prompted to list the names of all of the children for whom the father pays support. Click the Update button to proceed.
Audio Script:

If father pays support, state the Court and Cause Number related to each of father’s child support orders, if known. Click the Update button to proceed.
Audio Script:
Select yes or no to indicate whether or not the father currently receives support payments. In this example, no has been selected for you. Click the Update button to proceed.
Audio Script:

Now you are asked to describe the father's educational background. In other words, what was the last grade completed or degree received. For instance, GED, high school diploma, community college or last grade attended, etc. Click the Update button to proceed.
Audio Script:
This screen allows you to generally describe the father’s occupation. For example, construction, retail, mechanic, broker, food service employee, etc. Click the Update button to proceed.
Slide 136 - Quest Pre-Disposition Report (PDR) Simulation 56

Audio Script:

Next, you are asked to enter the name of the father’s employer. Include both the name and the address of the employer. Click the Update button to proceed.
Audio Script:

Enter the father’s work telephone number.  Click the Update button to proceed.
Select yes or no to indicate whether or not the father is of Native American heritage. This does not mean whether or not father claims membership of a registered Native American tribe. Only whether or not father states he has Native American heritage, to whatever degree. In this example, no has been selected for you. Click the Update button to proceed.
Audio Script:

Enter the source of the information about the father. This includes from father directly, mother, relatives, friends, technology such as ICWIS or ISETS or ICES, police reports, court information, etc. Click the Update button to proceed.
Audio Script:
Select yes or no to indicate whether or not there is a Step-parent, a guardian, or a custodian. In this example, no has been selected for you. Click the Update button to proceed.
Select the check box next to every child included in this document. In this example, child 1 has already been selected for you. Click the Update button to proceed.
Audio Script:
Select child 1’s name from the list. In this example, Brian Petty Johnson has already been selected for you. Click the Update button to proceed.
Audio Script:
Select child 1’s siblings who are not a part of this matter from the list. In this example, the child’s half-sister has already been selected for you. Click the Update button to proceed.
Audio Script:

Describe the child’s home conditions, living arrangement, relationship with those in the home and general neighborhood characteristics. For example, “Brian lives in a 3 bedroom apartment on the near east side of the city. In the home are Mother, 3 siblings and grandmother. The home is well-kept with electricity and heat. There is sufficient food. The house is messy, cluttered but livable. The neighborhood is a close knit apartment project with lots of children, but is known to have gang activity where drugs are easily obtained. The school the children attend is close by allowing them to walk to school. There are shops and a grocery store in close proximity.”
Audio Script:

Briefly describe child’s physical health, for example. “Brian is a child of average height and weight for his age. He has had minimal dental care which is noticeable. His immunizations are current but he rarely sees medical personnel except for emergency care. He has no noticeable scars but he has had several broken bones requiring medical care, limiting his physical activity.” Click the Update button to proceed.
Audio Script:

Now, you are asked to describe the child’s mental health, as currently known, including psychiatric and psychological needs. Medications being taken should be noted as well as whether any evaluations have been completed. For example: “Brian has been diagnosed with ADHD, and has displayed behavioral problems both at home and at school. He is currently in counseling and is taking medication. His current medications include Adderal. He has had an IEP to help address his behavioral problems in school.” Click the Update button to proceed.
Select yes or no to indicate whether an out of home placement is recommended. If the recommendation is for an out of home placement, click yes. You will then be instructed to complete additional questions relating to the placement. If out of home placement is not recommended, click no. In this example, yes has already been selected for you. Click the Update button to proceed.
Audio Script:
This screen prompts you to enter the name of the child’s current school district or the township of legal settlement that the child was attending at the time of removal. Click the Update button to proceed.
Audio Script:

If the child is not placed within the school district or township of legal settlement at the time of removal, enter the name of the school district or township, and the county where the child is now attending school. Click the Update button to proceed.
**Audio Script:**

While this seems repetitious, state again the child’s school district or township where the child attended at the time of removal. That is the school where the child was attending while the child was living with the parent, guardian or custodian. In addition, state the school name, district, township and county where it is recommended that the child attend school at this time. Click the Update button to proceed.
Audio Script:

Enter the grade number the child is currently attending in the text box provided. For instance, if the child is in 1st grade, type “1st”. If the child has not yet started school, type “not in school”. In this example, grade 10 has already been entered for you. Click the Update button to proceed.
Audio Script:

Identify the last grade attended in school, and whether or not the child has an Individualized Education Plan, or IEP. An IEP is a plan through the child’s home school to assist the child with any educational difficulties the child may have as identified through a formal evaluation process. You may also list the child’s current grade in school and give a general description of how they are performing. Click the Update button to proceed.
Audio Script:

Describe the child’s activities, memberships, interests, membership in organized groups, religious orientation and participation. In addition, describe how the child interacts with family members, for example: has a strained relationship with father, has physical altercations with siblings, is very close and protective of younger siblings, etc. Also, describe interpersonal relationships such as: plays well with other children at school, has a boyfriend, has been sexually active, uses drugs, etc. Click the Update button to proceed.
Audio Script:

Describe the child’s use of alcohol and or drugs, and the extent of use, if known. Be sure to include any intervention treatment and or counseling. Click the Update button to proceed.
Audio Script:

List whether the child has any employment, such as part-time job at a fast food restaurant, cuts grass, works on the weekends, etc. In addition, if the child has any assets, list those. For example, does the child have a trust account, income or money from settlement of an injury, or other possessions given or earned of a significant nature. Click the Update button to proceed.
Audio Script:

Enter professionals, by name and occupation, who have been consulted in preparation of the report. This may include communication, review of records from a counselor, therapist, teacher, probation officer, community mental health center, medical personnel, etc. If the child has an IEP, the FCM must consult with school personnel responsible for the IEP and include their contact information here. Click the Update button to proceed.
Now, list the names of the individuals that have participated in any Child and Family Team Meetings or Case Plan Conferences, if held. This needs to include dates of the meetings, names of the individuals, and their relationship to the child. Click the Update button to proceed.
Of the professional individuals previously listed, enter what those individuals recommended as needed for the child’s treatment program, including all recommendations for mental health treatment and/or identified physical or dental care. Click the Update button to proceed.
Audio Script:
List all dispositional options considered and evaluated in preparing the recommendations for care, treatment, rehabilitation or placement for the child. Reference Child and Family Team Meeting notes, if applicable. Click the Update button to proceed.
List all treatment, programs, and services of planned recommendations for the child by the individual preparing the report. This should include any treatment programs or services or placement in a numbered fashion. Click the Update button to proceed.
Audio Script:
Identify the specific recommended placement. If the recommended placement is with an individual, list the individual’s name and relationship to the child, for instance, placement with Mary Smith, maternal aunt, or placement in therapeutic foster care. (If foster care of any kind is recommended, do not list the individual foster parent by name). If the child is not currently in that placement, list the reason why the child is not currently there. If the recommendation is for a treatment facility, provide appropriate information such as name, location, per diem, etc. Click the Update button to proceed.
Audio Script:

Enter a description of how this recommended placement is the least restrictive and most appropriate placement. Describe how the proposed placement of the child meets the child’s needs. For instance, if the child is at home, describe how this child can safely remain at home with the recommended services, such as home based counseling, Intensive Family Preservation programming, etc. Specifically address the child’s needs such as supervision, health, counseling, educational, etc. and how the parents are able to address those needs with or without assistance.

If the child is placed out of home with a relative, foster parent, residential or other facility, etc., explain why remaining in home is not appropriate. For instance, the parents are not able to provide adequate supervision; the child’s treatment needs require more services than can be provided in home; the child’s safety cannot be assured in the home even with services, etc.

Click the Update button to proceed.
Audio Script:

Enter an explanation of how the recommended placement least interferes with the family autonomy. Generally, a parent, parents, or family, should be in a position to raise their children as they see fit. A treatment program that requires services for the child technically interferes with family autonomy. Therefore, statements such as parents physical, mental, or emotional conditions prevent them from providing supervision, insuring the safety of the child, making good decisions about medical care, etc., should be included. Since the purpose of this is to keep the family involved, why is it that the child cannot remain at home? Click the Update button to proceed.
Audio Script:

Explain why the placement recommendation is least disruptive to family life. In other words, DCS should intervene at the least restrictive level. Therefore, list any reasons why the proposed treatment program least interferes with the family life. Examples include: the placement in-home allows the parents to be involved daily in the treatment program. Placement with relative allows family and extended family to be more involved than if the child were placed in a foster home or institution. The placement in a foster home or another restrictive placement like residential, while disruptive to family life, is the least restrictive because it is close to the home so that the family can participate in visitation or other treatment programs. Click the Update button to proceed.
Audio Script:

Next, explain how this imposes the least restraint on the freedom of the child and the parent, guardian or custodian. If the child remains in the home, explain that the child remains in home with supportive services and that allows the family to have the freedom within their home environment to participate in a treatment program timely, and in the home if necessary. However, if the child is out of home, list the reasons that the out of home placement has the least restraint possible. For instance, if the child is placed in foster care or residential treatment, list why it is important to provide the services out of the home rather than in the home. Also, explain the possibility that there is a more restrictive placement so that the placement proposed provides the least restraint on the freedom, i.e. if the child is in relative care, the alternative placement may be in a foster home, or if the placement is in a residential facility, the alternative may be a secure residential program, etc. List why this out of home placement allows the parent, guardian or custodian to visit and participate in the treatment program and why the program can meet the specific needs of the child. Click the Update button to proceed.
List why this program provides reasonable opportunity for the participation by the child’s parent, guardian or custodian. For instance, if the child is placed in home, list that the placement in home provides the parents the opportunity to work with the child and the treatment program in the home. Alternatively, if the child is placed out of home, state why this program is necessary and that the parents can participate in that treatment program by visiting with the child, participating in a treatment program through joint counseling, etc.

Audio Script:
List why this program provides reasonable opportunity for the participation by the child’s parent, guardian or custodian. For instance, if the child is placed in home, list that the placement in home provides the parents the opportunity to work with the child and the treatment program in the home. Alternatively, if the child is placed out of home, state why this program is necessary and that the parents can participate in that treatment program by visiting with the child, participating in a treatment program through joint counseling, etc. Click the Update button to proceed.
vii. Describe how this placement is consistent with the safety and best interests of the child and the community. Describe any circumstances that would support the placement out of home as meeting the safety and best interest of the child and the community. For instance, if there was or is an issue of physical abuse in the home environment, how this will make the child safe while treatment services for the alleged perpetrator(s) are ongoing.

Audio Script:
Describe how this placement is consistent with the safety and best interests of the child and the community. If the placement is in home, describe why the child can safely remain there, through a CANS assessment, clinical assessments, or otherwise indicate that in-home placement is appropriate. If the placement is out of home, in relative care, foster care, residential placements, describe why this will make the child safe and is therefore in the child’s best interest. Review that parent drug use, family domestic violence, behavioral challenges by the child, physical or sexual victimization, or other issues threaten the safety of the child in the home and/or the community making placement necessary. Click the Update button to proceed.
Select the options regarding placement that is relative to this child. In this example, a selection has been made for you. Click the Update button to proceed.
Enter any other relevant and important information for someone to understand the reason behind the recommendation. You may also list names and relationships of others and whether or not they support the placement recommendation. Click the Update button to proceed.
Audio Script:
List the ways in which the parent, guardian, or custodian should be referred to services and the nature and extent of those services. Often, the parent, guardian or custodian, will be referred to services or required to participate in a treatment program. List in numbered order, the recommendations to the Court for treatment services for the parent/guardian/custodian. For instance, list by name of the person, (1) parent should participate in counseling; (2) parent should participate in drug/alcohol treatment; (3) parent should participate in domestic violence treatment; (4) parent should visit with the child regularly; (5) parent should keep in touch with the case manager on a regular basis; (6) parent should notify the case manager of any change in address or telephone number; etc.

Click the Update button to proceed.
Audio Script:

If no order is requested restricting contact with the child, enter “not applicable”. If there is a need for restricting contact with the child for safety reasons, list the individual who should not have contact, why there should be no contact, and how this will provide safety for the child. Click the Update button to proceed.
Visitation is often an important part of the treatment program for the child and the family. Identify any visitation requests that may restrict or allow visitation with the child. For instance, list by individual whether or not there should be unrestricted visits, unsupervised visits, or supervised visits. Also list, if requested, any limit on the amount of time by hour or frequency such as weekends, overnight, one hour supervised, etc. Click the Update button to proceed.
List all of the mother's income and the source. List her income in dollars per week or however she is paid. Also list any other source of income such as retirement/pension, social security, etc. Click the Update button to proceed.
Audio Script:
List all of the father’s income and the source of the income. List his income in dollars per week or however he is paid. Also list any other source of income such as retirement/pension, social security, etc. Click the Update button to proceed.
Slide 175 - Quest Pre-Disposition Report (PDR) Simulation 95

Audio Script:
List all of the step-parent, guardian, or custodian’s income and the source of the income. List income in dollars per week or however step-parent, guardian or custodian is paid. Also list any other source of income such as retirement/pension, social security, etc. Click the Update button to proceed.
Audio Script:
List all of the child’s income and the source of the income. List child’s income in dollars per week or however he/she is paid. Also list any other source of income, listing each child’s name and income. Click the Update button to proceed.
Audio Script:

Select the financial responsibility from the list of available options. If DCS has made disbursements or paid for services, list what services and the amount paid. If DCS is requesting that a party reimburse DCS for those costs, check the first box. If DCS is not requesting that a party reimburse DCS for those costs, check the second box. If DCS is asking for a new support order to be established, or assignment of an existing support order under a divorce or paternity decree, check the third box. If DCS is not asking for a support order, check the 4th box. If there has been a previous order in this case regarding reimbursement or support and there is no request for a change in that order, check the fifth box. In this example, There is no change in the financial report DCS recommendation as to financial responsibility, has been selected for you. Click the Update button to proceed.
Audio Script:
List the services available prior to the current proceedings. This could include TANF benefits, Social Security Benefits, food stamps, counseling, foster care, etc., including services offered pursuant to any prior CHINS, IA or SRA, or in this case. Click the Update button to proceed.
If removal is being requested at this time, enter a summary of why reasonable efforts to prevent the removal have not been successful, and why the child must be removed. For example: the child’s safety is now at risk because of failure to complete services, domestic violence, drug or alcohol use, etc. If the child has previously been removed, list why the child cannot be returned home at this time. For instance – parent has not completed drug treatment, has no stable home, continues to live with the perpetrator of the original abuse, etc.

Audio Script:
If removal is being requested at this time, enter a summary of why reasonable efforts to prevent the removal have not been successful, and why the child must be removed. For example: the child’s safety is now at risk because of failure to complete services, domestic violence, drug or alcohol use, etc. If the child has previously been removed, list why the child cannot be returned to the home at this time. For instance – parent has not completed drug treatment, has no stable home, continues to live with the perpetrator of the original abuse, etc. Click the Update button to proceed.
Audio Script:

Now you are asked to enter reasonable steps toward a plan of permanency. You may choose to include other information such as the cooperation of the parent, guardian, or custodian, the success and participation in the Child and Family Team Meetings, efforts to facilitate the action to closure in a timely manner, or anything to indicate that services are not being successful and special admonitions should be made by the Court to the individuals about their participation and cooperation. Click the Update button to proceed.
Audio Script:

Enter the permanency plan for each child, as well as the concurrent plan being pursued for each child. State for each child listed in this document what the permanency plan is. It should be one of the following:
- Reunification;
- Guardianship;
- Placement with a fit and willing relative;
- Another planned permanent living arrangement; or
- Adoption

Click the Update button to proceed.
Slide 182 - Quest Pre-Disposition Report (PDR) Simulation 102

Audio Script:
Select yes or no to indicate whether Court approval of the plan is recommended. In this example, yes has been selected for you. Click the Update button to proceed.
Audio Script:

Enter all of the recommendations that are being made in the case. List here in summary all of the recommendations for each party. For instance, mother should participate in counseling, drug testing, visit with the child, maintain suitable housing and income, keeping contact with the FCM, etc. Also, list that the permanency plan is reunification, guardianship, etc. Click the Update button to proceed.
Audio Script:
Select the name of the FCM that this case will be assigned to. If the FCMs name doesn't appear in the list, click the New Case assignment link to add it. In this example, the FCM has been selected for you. Click the Update button to proceed.
Audio Script:

Enter the name of the county. This should be the county where the case is heard, for instance, Allen, Benton, Cass, etc. In this example, the county has already been entered for you. Click the Update button to proceed.
Audio Script:

Now you are asked to enter the name of the supervisor who will be approving this document. Type this name in the box provided. In this example, the supervisor's name has been entered for you. Click the Update button to proceed.
Audio Script:

Enter the effective date of this document. Use the date that the hearing for this report is scheduled. In this example, a date has been entered for you. Click the Update button to proceed.
Audio Script:

Now you are required to enter the ID, and agency of the supervisor who will be approving this document. If you are unsure of the supervisors ID, ask the supervisor. The Employer agency will always be DCS, Department of Child Services. In this example, these fields have been completed for you. Click the Update button to proceed.
Audio Script:
Select any items that will be attached to this document from the list provided. In this example, no selections have been made. In a real scenario, if you were to choose one of these options, you would be prompted to enter details about each attached item. For instance, the case plan dated 1-1-09 or the report of service provider ABC dated 1-1-09, etc. Click the Update button to proceed.
Audio Script:
This screen informs you that there are no more questions to process. Your Predisposition Report is complete. If you want to return to the most recent question, click backwards. If you want to go back to the first question, click top. If you want to review the form in its entirety as it has been prepared, or if you would like to send a copy of the form to an attorney to review and make suggestions, click preview and then send an email to the attorney in your county. If you want to complete the form, click finish.
Quest Help, Tips and Tricks

- **Copy and Paste**
  - This feature is available in Quest

- **Automatic Logoff**
  - You will be automatically logged off after 60 minutes of inactivity
  - Typing in a text box does not count as activity

- **Browser’s Back Button**
  - Do NOT use the button of your browser
  - Use the button on the Quest screen instead

- **Button Shortcuts**
  - Press \text{Alt} +x where x is the first character of the text inside the button. This is the same as clicking on the button

Audio Script:

The following slides offer some tips and tricks for navigating the Quest application. Copy and Paste functionality is available in Quest. You can easily add information from another document into the Quest Court form by copying the desired information and pasting it into the Court Form within Quest.

Automatic log off
You will be automatically logged off Quest after 60 minutes of inactivity. Inactivity results from you either not pressing one of the links or not pressing one of the buttons on the Quest page. Entering information in a text box does NOT count as activity.

Browser’s BACK button
Do NOT use the BACK button of the browser while using Quest. Instead, use the CANCEL button on the Quest screen. If you use BACK, you will either get a message from your browser telling you the page has expired or you will receive a similar message from Quest if you try to perform a subsequent update.

Button shortcuts
Hold down the alt key and press the first character of the text inside the button. This is the same as clicking on the button.
**Quest Help, Tips and Tricks**

- **Checkboxes**
  - Use the `Tab` key to navigate to different checkboxes and use the spacebar to check/uncheck the currently highlighted checkbox.

- **Dropdown List**
  - Press the first letter of the code to jump to that item in the list.
  - If multiple items begin with the same letter, keep pressing it to cycle through the items beginning with that letter.

- **Spell Check**
  - All note fields may be spell checked.
  - Simply press the `Tab` key and then press `Enter` or click directly on the spell check link.

---

**Audio Script:**

**Checkboxes**
You may press the tab key to move between checkboxes, and press the space bar to check or uncheck the currently highlighted checkbox.

**Drop down lists**
You may press the first letter of the code to jump to that item in a drop down list. If there are multiple items that start with the same letter, repeatedly pressing the letter cycles through each item.

**Spell check**
All note fields may be spell checked. To access spell check, simply press the tab key from within the note field in which you are typing, and then press enter to perform the spell check. Alternatively, you may simply click on the Spell check link displayed on the screen.
Quest Help, Tips and Tricks

- Date and Date/Time
  - Most required date fields default to the current date (and time if necessary) if left blank

- Time/Date Shortcuts:
  - T Defaults to today (the current date or date/time)
  - + Increments the date by 1 day
  - 3 Increments the date by 30 days
  - 6 Increments the date by 60 days
  - 9 Increments the date by 90 days
  - - Increments the date by 1 day
  - M Jumps to the beginning of the month

Audio Script:

Entering dates or dates and times
If left blank, most required date fields default to the current date, and time as necessary. If you wish to type a date, there are shortcuts associated with the fields to simplify data entry.
Pressing 'T' defaults to the current date or date and time.
Pressing the plus sign increments the date by 1 day.
Pressing the Shift key and then the number 3 increments the date by 30 days.
Pressing the Shift key and then the number 6 increments the date by 60 days.
Pressing the shift key and then the number 9 increments the date by 90 days.
Pressing the minus sign decrements the date by 1 day.
Pressing the 'M' key jumps to the beginning of the month.

These are actually easier to remember than they may first appear. The word month begins with 'M' and ends with 'H', which are the keys you use to navigate by month. The word year begins with 'Y' and ends with 'R', which are the keys you use to navigate by year.
Quest Help, Tips and Tricks

- Date and Date/Time
  - Dates/times may be entered in any of the following formats:
    - mm/dd/yy
    - mmddyy
    - mm/dd/yy hh:mm:ss am (or pm or a or p)
    - mm/dd/yy hh:mm am (or pm or a or p)
    - mm/dd/yy hh:mm:ss (military time)
    - mm/dd/yy hh:mm (military time)
    - mmddyy hhmmss (military time)
    - mmddyy hhmm (military time)

Audio Script:
Dates and times may be entered using any of the formats shown on your screen. When you are finished viewing this slide, click the Continue button.
Quest Help, Tips and Tricks

- **Change your password**
  - Perform a name search on your own name and select it to view the Identity Detail screen
  - Passwords ARE case sensitive

- **Printing**
  - You may print any page by simply using the Print command from your browser
  - You may also use the Miscellaneous>View>Print Friendly option from the menu

- **Expert Mode**
  - Select Miscellaneous>View>Expert Mode on/off from the menu

- **Configuring the Quest Menu Bar Location**
  - Select Miscellaneous>View>Switch menu location option from the menu

Audio Script:

Change your password
To change your password, simply perform a name search on your own name, and select it to get to the Identity detail screen. You may change your password on that screen. Since you won’t be able to see what you type, you must type it twice to ensure you have not made a mistake. Keep in mind that passwords are case sensitive so pay attention to whether you are typing in upper or lower case.

Printing
In general, you may print any page without doing anything special. If however, you are able to update fields on the screen and don’t like the looks of the printed output with boxes around the input fields, use the Miscellaneous, View, Print friendly, option from the Quest menu. After printing, simply press the Refresh or Cancel button.

(continued on next page)
(Quest Help 5 Audio Script - continued from previous page)

Expert mode
If you know the coded values for all the drop down entry fields and would prefer to simply type the code rather than select it from the drop down list, select the Miscellaneous, View, Expert mode on or off option from the Quest main menu. This option will toggle between drop downs or radio buttons displaying, and simple text entry fields.

Configuring the Quest menu bar
If the Quest menu bar is located on the left side of your screen, and you feel it takes up too much space, you may use the Miscellaneous, View, Switch menu location, option from the Quest main menu. This will toggle the menu location between the left side of the screen, and the top of the screen. When the menu is located at the top of the screen, there is more screen area available for data to be displayed. Another useful thing you can do to gain even more space in Internet Explorer is press the F 11 key, to toggle in and out of full screen mode.
Font and Text Size
- Quest will display whatever font is used within your web browser. If you use Internet Explorer, you may change this in the Tools>Internet Options>General>Fonts options
- In Internet Explorer, you may increase/decrease the size of the text displayed using the Text Size option located in the View menu

Finding Text on a Screen
- Use Ctrl + F to search for specific text on any screen

Audio Script:
Font and text size
Whatever font your browser is set to will be used within Quest. In Internet Explorer, this may be set using the browsers Tools, Internet Options, General, Fonts, option. You can also adjust the size of the text displayed. In Internet Explorer, this may be set using the browser’s View, Text size, option. Finally, your system settings for menu font and color affect the Quest sub-menus.

Finding text on a screen
If you use Internet Explorer, you can always hold down the control button and press the F key to search for
specific text on any screen.
Slide 197 - Quest Help 7

Quest Help, Tips and Tricks

- Switch to File/Case
  - Appears in the Quest menu
  - Allows you to quickly change the file number or case/cause/petition number you are viewing

Audio Script:
The image on your screen appears when the Quest menu is displayed on the left hand side of the screen. You have the ability to change the identity, and or case for which you are currently viewing. File, refers to the file number of the identity for whom you are interested. Case, refers to either the sequential case number for the identity, a cause number, or a petition number. You may enter either File, Case, or both. Provided you are viewing information dependent upon the identity or case, your screen will change to reflect the new information when you press the Go button.
Audio Script:
For technical challenges related to Quest, contact Robert Johnson at robert.johnson@dcs.in.gov.
For questions on navigating through the Quest application to complete court forms, contact your ICWIS Coordinator.
For questions on the content for the court forms, please see your supervisor.
Thank You

This concludes training on the use of the Quest electronic form submission system

Presented by the Indiana Department of Child Services

Audio Script:
This concludes the training on the use of the Quest electronic form submission system. Presented by the Indiana Department of Child Services. Thank You.